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 How to Use this Manual 

1 How to Use this Manual 

The layout of this manual is designed to provide quick reference to the sections of interest to the user. 
However, we recommend that you review the manual thoroughly before beginning operation of the 
license server in order to obtain full understanding. 

At various points throughout the manual, messages of particular importance are indicated by certain 
symbols: 
 

 Note: Indicates general information intended to optimize the performance. 

 Tip: Indicates that failure to take note of the accompanying information may produce 
wrong results. 

This manual is provided "as is." Every effort has been made to supply complete and accurate 
information and all technical specifications have been developed with the utmost care. However, 
Dionex assumes no responsibility and cannot be held liable for any errors, omissions, damage, or loss 
that might result from any use of this manual or the information contained therein. We appreciate your 
help in eliminating any errors that may appear in this document. 

The information contained in this document is subject to change without notice. 

CHROMELEON® is a registered trademark of Dionex. All other trade or company names mentioned 
are subject to the copyright and the property and trademark rights of the respective companies. 

All rights reserved, including those for photomechanical reproduction and storage on electronic media. 
No part of this publication may be copied or distributed, transmitted, transcribed, stored in a retrieval 
system, or transmitted into any human or computer language, in any form or by any means, electronic, 
mechanical, magnetic, manual, or otherwise, or disclosed to third parties without the express written 
permission of Dionex. 
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2 Overview 

In installations with numerous computers, it is a fatiguing task to equip all clients with the 
corresponding hardware and enter the respective license codes. That is why the Chromeleon license 
server was developed. 

Running the license server requires a key code that is available in the ini-file included in the shipment. 
Together with the serial number that is filed in the hardware (dongle, hard-protect) the key code allows 
accessing the licensed software features. 
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3 Description 

3.1 Installing the License Server 

The license server can be installed on any network PC fulfilling the following conditions: 

 Windows 2000, Windows XP, Windows Vista (32-bit/64-bit), Windows 7 (32-bit/64-bit), Windows 
Server 2003 or Windows Server 2008 R2 Operating System 

 LAN connection via TCP/IP or IPX/SPX 
 The license server must not be installed on systems that are configured as Primary Domain 

Controller (PDC). Due to the security settings implemented on these systems, the license server 
installation is blocked. 

 Tips: Make sure that the person performing the installation has full local administrator 
privileges. Otherwise, the installation will fail or be incomplete. After reboot, the 
administrator running the setup must login again so that the installation process 
can be completed correctly. 

 If a firewall is active on the PC (for example under Windows XP Service Pack 2), 
the CmLicSrv.exe program must be included in the exceptions list. For Windows 
XP, for example, click Start > Control Panel > Windows Firewall. On the 
Exceptions tab page, click Add Program and then click Browse to select the file. 
Under Windows Server 2008, you must also add the rule "COM + Network". To 
do so, select the respective check box on the Exception tab page. 

3.1.1 New Installation 
 
1. Insert the distribution CD that is shipped with the product into the CD drive of your computer. The 

installation screen opens automatically if CD Autostart is active on your PC (otherwise, you may 
go to the Autorun folder on the CD and start autorun.exe from there).  

2. To install the license server, select License Server Setup. The installation wizard guides you 
through the installation process. Clicking Next takes you to the second wizard page. 

3. Specify the destination folder for the installation. If Chromeleon is already installed on your PC, 
the corresponding message appears. We recommend installing the license server into a folder 
different from the Chromeleon installation folder. The default folder is C:\CmLicSrv. To use a 
different folder, navigate to the desired destination using the Browse... button. Clicking Next 
takes you to the next Wizard page. 

If the CmLicSrv directory does not yet exist on your PC, a message appears. Click Yes to confirm the 
prompt whether to create the folder (Should Setup create it for you?).   

4. Before starting the installation, a confirmation page is displayed indicating the selected 
installation path. Click Next to confirm the installation path and to proceed to the next wizard 
page. (Clicking Back returns you to the previous page where you can edit the installation options; 
clicking Cancel aborts the installation.) 

5. As no license server has been installed on your PC, a license file (= CmLicSrv.ini) is requested. 
(The license server needs a license file ("CmLicSrv.ini") to start. Do you want to install this file 
now?). Click Yes to install the file. Clicking Next takes you to the next page.  

6. The ini-file for your license is available on the disk that is shipped with the product. In the File 
Selection box, specify the path accordingly and click Open to confirm your selection.   

7. To complete the installation of the license server, you have to restart your computer. Select the 
desired option (Yes, I want to restart my computer now or No, I will restart my computer 
later), and then click Finish to complete the license server installation. 

8. When you have restarted your computer, the Setup Finish wizard page appears. Use this page 
to determine whether the license server monitor is started immediately (Start License Server 
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Monitor now?) and/or whether the license server icon is added to the system tray (Add License 
Server Monitor to the taskbar?). Select the desired option(s), and then click Finish. 

9. The CmLicSrv.ini file needs to be adapted to the local requirements (if a new ini-file has been 
installed).In the [Servers] section, replace the computer names PC_XX by the names actually 
used on your network to assign serial number/key code pairs to the Chromeleon servers:  

 

[License Server] 
Serial Number = 4711 
Key Code = 112233-445566 
Pal Location = 5 
 
[Servers] 
ALPHA   :1/111111-111111 
BRAVO   :2/222222-222222 
CHARLIE :3/333333-333333 
DELTA   :4/444444-444444 
ECHO    :5/555555-555555 
FOXTROTT:6/666666-666666 
 
[Clients] 
Max Clients = 10 
 
[Checksum] 
Checksum = 0x00005E77 
 

  Tips: The information about the number of full licenses can be obtained from the key 
codes of the separate server PCs. These licenses can only be used on the 
indicated PC (e.g., ALPHA, BRAVO, …). In addition, floating licenses are 
available for any PC on the network. For information about the number of 
floating licenses, see Max Clients underneath [Clients]. In the above example, 
10 floating licenses are available. 

If you have a hard-protect installed (that is, if the entry in the INI file reads: Pal 
Location = 1), specify an I/O address. Enter the line "Pal Address = 0x030F". 
Depending on the jumper settings on the hard-protect, other available options 
are: 0x031F, 0x032F, and 0x033F. If the "Pal Address =" line is missing in the 
INI file, 0x030F is the default. 

Do not modify any other settings! 

If the license server is not yet running, start the license server via the License Server Monitor. For 
information about how to configure the client and server PCs (that is, about how to establish the 
license reference), see sections 3.2 and 3.3, respectively. 
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3.1.2 Upgrading the License Server  

 Tip: Before starting an upgrade make sure that the license server and the server 
monitor are disabled. Verify that neither the server monitor icon nor any 
minimized program button is displayed on the Windows taskbar! 

3.1.2.1 Upgrading a License Server Version 6.20  or earlier 
 

 Tip: When you upgrade your Chromeleon installation that includes a license server, 
observe the following order: First, install the Chromeleon 6.80 SR10 license server! 
An old license server (6.40 or earlier) cannot provide Chromeleon clients and 
servers 
with version 6.50 or higher with a license! However, Chromeleon clients and 
servers 6.40 or earlier can receive their licenses 
from a Chromeleon 6.50 and higher license server. 

Therefore, upgrade the license server before upgrading any computers 
receiving their licenses from the license server. 

If a license server version 6.20 or earlier is already installed on your PC, this 
installation will not be recognized as such during setup. 

1. Therefore, install the license server as described in 3.1.1 selecting the installation directory of the 
old installation. A message appears indicating that an old license file for the Chromeleon server 
has been detected and in which folder. .  

The old key codes are invalid for a Chromeleon 6.50 and higher license servers. Thus, when you 
update the license server to version 6.50 or higher, you always need a new CmLicSrv.ini file. 

2. Select the Install a new license file option. Clicking Next takes you to the Please select the 
license file ("CmLicSrv.ini") dialog box. Navigate to the new license file, and then click Open. 

 Note:  If you do not yet have a new CmLicSrv file, you may still use the old file. The old 
key codes are accepted for a transition period of 30 days. The transition period 
starts with the upgrade of the Chromeleon server or client. 

3. The new CmLicSrv.ini file needs to be adapted to the local requirements. For an example for a 
CmLicSrv.ini file after an upgrade, refer to page 7.  
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3.1.2.2 Upgrading a License Server Version 6.30 or 6.40 

 Tip: When you upgrade your Chromeleon installation that includes a license server, 
observe the following order: First, install the Chromeleon 6.80 SR10 license 
server! An old license server (6.40 or earlier) cannot provide Chromeleon 6.50 or 
higher clients and servers with a license! However, Chromeleon clients and 
servers 6.40 or earlier can receive their licenses from a Chromeleon 6.50 or 
higher license server. 

Therefore, upgrade the license server before upgrading any computers 
receiving their licenses from the license server. 

1. Insert the distribution CD that is shipped with the product into the CD drive of your computer. The 
installation screens opens automatically if CD Autostart is active on your PC (otherwise, you may 
go to the Autorun folder on the CD and start autorun.exe from there).  

2. To install the license server, select License Server Setup. The installation wizard guides you 
through the installation process. Clicking Next takes you to the second wizard page. 

3. A message informs you that the license server is already installed on your computer. Select 
Upgrade / Repair License Server and click Next.  

4. A message on the next wizard page informs you that an old license file has been detected and in 
which folder.   

The old key codes are invalid for a Chromeleon license server 6.50. Thus, when you update the 
license server, you always need a new CmLicSrv.ini file. 

5. Select the Install a new license file option. Clicking Next takes you to the Please select the 
license file ("CmLicSrv.ini") dialog box. Navigate to the new license file, and then click Open. 

 Note:  If you do not yet have a new CmLicSrv file, you may still use the old file. The old 
key codes are accepted for a transition period of 30 days. The transition period 
starts with the upgrade of the Chromeleon server or client. 

6. The new CmLicSrv.ini file needs to be adapted to the local requirements. In the [Servers] 
section, replace the computer names PC_XX by the names actually used on your network to 
assign serial number/key code pairs to the Chromeleon servers.  
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When you have updated your license server to a version higher version, the file looks as follows 
(for the example below, upgrade from 6.40 to 6.50): 

 

[License Server] 
Serial Number = 666 
Key Code = XXXXXX-XXXXXX 
Key Code 640 = YYYYYY-YYYYYY 
Pal Location = 5 
 
[Servers] 
ALPHA   :1/AAAAAA-AAAAAA 
BRAVO   :2/BBBBBB-BBBBBB 
 
[Servers 640] 
1/CCCCCC-CCCCCC 
2/DDDDDD-DDDDDD 
 
[Clients] 
Max Clients = 5 
 
[Checksum] 
Checksum = 0x12345678 
 

The Key Code 640 and [Servers 640] sections are only part of the file after upgrading. They allow 
you to continue operation of Chromeleon 6.40 clients and servers for the moment and to upgrade 
them one after the other. The license server recognizes whether the license is inquired by a 
Chromeleon 6.40 or a Chromeleon 6.50 client (or server). Thus, the computer automatically receives 
the new key code if the update is performed. 

 Tips: The information about the number of full licenses is included in the key codes of 
the separate server PCs. These licenses can only be used on the indicated PC 
(e.g., ALPHA, BRAVO, …). In addition, floating licenses are available for any 
PC on the network. For information about the number of floating licenses, see 
Max Clients under [Clients]. In the above example, 5 floating licenses are 
available. 

If you have a hard-protect installed (that is, if the entry in the INI file reads: Pal 
Location = 1), specify an I/O address. Enter the line "Pal Address = 0x030F". 
Depending on the jumper settings on the hard-protect, other available options 
are: 0x031F, 0x032F, and 0x033F. If the "Pal Address =" line is missing in the 
INI file, 0x030F is the default. 

Do not modify any other settings! 

7. To complete the installation of the license server, you have to restart your computer. Select the 
desired option (Yes, I want to restart my computer now or No, I will restart my computer 
later), and then click Finish to complete the license server installation. 

8. When you have restarted your computer, the Setup Finish wizard page appears. Use this page 
to determine whether the license server monitor is started immediately (Start License Server 
Monitor now?) and/or whether the license server icon is added to the system tray (Add License 
Server Monitor to the taskbar?). Select the desired option(s), and then click Finish. 

9. If the license server is not yet running, start the license server via the License Server Monitor. For 
information about how to configure the client and server PCs (that is, about how to establish the 
license reference), see sections 3.2 and 3.3, respectively. 
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3.1.2.3 Upgrading a License Server from Version 6.50 

1. Insert the distribution CD that is shipped with the product into the CD drive of your computer. The 
installation screen opens automatically if CD Autostart is active on your PC (otherwise, you may 
go to the Autorun folder on the CD and start autorun.exe from there).  

2. To install the license server, select License Server Setup. The installation wizard guides you 
through the installation process. Clicking Next takes you to the second wizard page. 

3. A message informs you that the license server is already installed on your computer. Select 
Upgrade / Repair License Server and click Next.  

4. The license server is updated and the next wizard page is opened. Select Reuse existing 
license file and click Next. 

5. To complete the installation of the license server, you have to restart your computer. Select the 
desired option (Yes, I want to restart my computer now or No, I will restart my computer 
later), and then click Finish to complete the license server installation.  

6. When you have restarted your computer, the Setup Finish wizard page appears. Use this page 
to determine whether the license server monitor is started immediately (Start License Server 
Monitor now?) and/or whether the license server icon is added to the system tray (Add License 
Server Monitor to the taskbar?). Select the desired option(s), and then click Finish. 

7. If the license server is not yet running, start the license server via the License Server Monitor. For 
information about how to configure the client and server PCs (that is, about how to establish the 
license reference), see sections 3.2 and 3.3, respectively. 

3.1.3 Uninstalling the License Server 

The license server can be uninstalled using the Windows Control Panel.  

1. Open the Windows Start menu and navigate to the Control Panel. 

2. Open the list of installed programs. 

3. From the list of currently installed programs, select the license server and follow the on-screen 
instructions to uninstall the program. 

 Notes:  Uninstalling the license server can also be performed via the License Server 
Setup of the distribution CD. To uninstall the license server (from version 6.30 
on) but not Chromeleon, you have to run the setup for Chromeleon once again 
and vice versa. 

 After deinstallation of the license server, problems when connecting to the 
CmUser database may occur in rare cases. Should a corresponding error 
message be displayed upon starting the Chromeleon Client program, reinstall the 
CmUser program. Then start the CmSecure program and turn the User Mode on 
and off again. 
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3.2 Configuring a PC with a Chromeleon Server 
 
Establish the license reference for a Chromeleon server PC in the Server Configuration program.   

1. Start the local Chromeleon server via the Server Monitor program. For the moment, the server 
runs in evaluation mode, as no license is available. Then, start the Server Configuration program 
(Start > Programs > Chromeleon > Server Configuration).  

2. When the connection to the Chromeleon server is successful, assign the server properties. Right-
click the server name and then select Properties on the context menu.The following dialog 
appears:  

 

3. On the License tab page, select License Server; the Key Code field is now disabled, as it is no 
longer required. Click the '...' button (Browse) to the right of the License Server option to open 
the next dialog. Select the computer on which the License Server runs: 
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4. Enter the name of the License Server PC or select a PC from the network list in the right window 
section. In addition, select a network protocol from the protocol list by means of which the local 
PC can connect to the License Server PC. 

 Tip: If "Server not found" is displayed in the list on the right, a firewall may be active 
on the PC and CmLicSrv.exe is not included in the exceptions list (see page 3). 

Click OK to close both dialogs. This action reconfigures the local Chromeleon client. In future, the 
license will refer to the selected Chromeleon License Server if the connection can be established via 
the settings made. 

5. On the File menu, select Save Installation to save the installation. 

3.3 Configuring a PC with a Pure Chromeleon Client 

Establish the license reference for a PC on which no Chromeleon server is installed directly in the 
Chromeleon client.  

1. Start Chromeleon and open the following dialog by selecting the Preferences command on the 
File menu. 

 

 
 

2. On the License tab page, select License Server; the Key Code field is now disabled, as it is no 
longer required. Click the '...' button (Browse) to the right of the License Server option to open 
the next dialog. Select the computer on which the License Server runs: 
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3. Enter the name of the Chromeleon server PC or select one from the network list in the right 
window section. In addition, select a network protocol from the protocol list by means of which the 
local PC can connect to the License Server PC. 

 Tip: If "Server not found" is displayed in the list on the right, a firewall may be active 
on the PC and CmLicSrv.exe is not included in the exceptions list (see page 3). 

Click OK to close both dialogs. This action reconfigures the local Chromeleon client. In future, the 
license will refer to the selected Chromeleon License Server if the connection can be established via 
the settings made.  
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3.4 Checking the License Information 

To check whether the connection to the License Server was established successfully and which 
licenses are available, open Help > About Chromeleon (the example refers to a Chromeleon server 
license): 
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3.5 License Server Report 

The Chromeleon License Server Monitor allows you to output a report describing the status of the 
Chromeleon License Server.   

1. Double-click the License Server Monitor icon on the taskbar. The Server Monitor program is 
opened:  

 

 

2. To open the report window, click Report... while the Chromeleon License Server is active.  

You can then copy the report to the Windows clipboard, print it on the standard printer, or save it in a 
CmLicSrv.txt file. The report looks as follows:  

 

License Server Connection Report 
Server SERVERNAME - Mon Feb 29 00:00:00: 
 Serial number 4711, key code 112233-445566 
 
Server licenses: 
 Server Serial No Key Code  active since 
 ALPHA  1  111111-111111 Fri Feb 26 11:22:33 
 BRAVO  2  222222-222222 --- not active --- 
 CHARLIE  3  333333-333333 --- not active --- 
 DELTA  4  444444-444444 --- not active --- 
 ECHO  5  555555-555555 --- not active --- 
 FOXTROTT  6  666666-666666 Thu Feb 25 01:02:03 
 
Connected Clients: 
 Client PC UserID active since 
 GOLF  Ruth  Son Feb 28 04:05:06 
 

Chromeleon License Server Page 13 



Troubleshooting 

3.6 Troubleshooting 

 The Chromeleon License Server does not start 

First, check the Event Viewer for your system. The path is: Start > Settings > Control Panel > 
Administrative Tools > Event Viewer > Application Log. 

CmLicSrv logs the server start and indicates possible errors. If the information displayed in the 
Event Viewer is not sufficient, you can enable extended output. 

Start the CmLicSrv program via the control panel and not via the License Server Monitor program. 

 

Select Properties on the context menu. The General tab page is opened. 

 

Enter /console in the Start parameters field and then click Start to start the Chromeleon License 
Server service.   

All detected entries of the CmLicSrv.ini license file, possible errors, and all connection attempts of 
the Chromeleon servers and Chromeleon clients are logged.  
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 The Chromeleon License Server has no licenses ("No Licenses Available") 

1. Check whether the hardware protection module (dongle or hard-protect) has been installed 
correctly. The serial numbers of the module and in the [License Server] section of 
CmLicSrv.ini must be identical. 

2. Check whether the Pal Location entry in the [License Server] section of CmLicSrv.ini has 
been modified. "5" is the correct entry for dongles, while "1" corresponds to hard-protects. 

 The Chromeleon Server starts but receives no license ("Evaluation Mode") 

1. In the Chromeleon Server Configuration program, verify that the computer name for the 
License Server is correct.  

2. Check whether the correct RPC protocol is used.  

3. Also, check whether the PC on which the License Server is installed can be accessed via the 
network; for example, for a TCP/IP network, use ping servername or open a network share in 
the Windows Explorer. 

4. Check whether a line for the Chromeleon server is provided in the CmLicSrv.ini file. Verify 
that the computer name is spelled correctly in the [Servers] section. The computer name must 
comply with the NetBIOS computer name (max. 15 characters). The NetBIOS computer name 
can be found using Start->Control Panel->System->Computer Name; on the Computer 
name tab locate and click on Change.  

5. If a firewall is active on the PC, verify that the CmLicSrv.exe file is included in the exceptions 
list (see page 3). 

 The Chromeleon Server starts, but, the device drivers report that a device control feature is 
missing when loading 

The starting sequence for the two server services, the Chromeleon Driver and Chromeleon Server, 
is wrong. Uninstall the services via the Server Monitor program: C:\Chromel\Bin>cmReg 
/deinstall. Restart the computer and reinstall the services via the Chromeleon Server Monitor 
program: C:\Chromel\Bin>cmReg /install.  

 The Chromeleon Client receives no license ("Evaluation Mode") 

1. Verify in the Chromeleon client that the computer name for the License Server is correct.  

2. Check whether the correct RPC protocol is used.  

3. Also, check whether the PC on which the License Server is installed can be accessed via the 
network; for example, for a TCP/IP network, use ping servername or open a network share in 
the Windows Explorer. 

4. Check in the Chromeleon License Server Monitor report to see whether the maximum number 
of licenses for clients has been reached. Restart the License Server, if necessary. 

5. If a firewall is active on the PC, verify that the CmLicSrv.exe file is included in the exceptions 
list (see page 3). 
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 Network Failure 

Under normal circumstances, network failure does not cause damage. Both, the Chromeleon 
server and the Chromeleon client save the license information locally for up to 7 days. The user 
can usually continue working during this period even if the License Server cannot be accessed. 
After this period, the Chromeleon server will shut down and the client will run in evaluation mode. 

If the connection to the Chromeleon License Server is disrupted during active operation or if the 
connection is not available when the system is started, these events logged in the daily audit trail. 
In this case, a dialog box appears on the client indicating the remaining time. In addition, the audit 
trails logs when the connection to the Chromeleon License Server is available again. The two audit 
trail messages look as follows: 

Warning: Chromeleon server failed to retrieve a license from the License Server CCHROMEL! 
Your local license will expire in 167 hours. 

Chromeleon server succeeded to retrieve a license from the License Server CCHROMEL! Your 
local license has been updated. 

 

 Could not create "Chromeleon Operators" group - No mapping between account names and 
security IDs was done  

During the installation of the License Server on a Windows a 2000/XP Backup Domain Controller, 
the following error message may appear when calling in CmLicReg.exe /install: Could not create 
"Chromeleon Operators" group - No mapping between account names and security IDs was 
done (8b2). Remedial action: Create the group via the Windows 2000/XP User Manager before 
you run CmLicReg.exe /install. 

 When you start the License Server, a "License Expiration Warning" appears. 

When you start the License Server, the following warning appears: 
 

 

This message is displayed during the transition period. It is a reminder that you are still using an 
old key code ( Chromeleon 6.40) or an old CmLicSrv.ini file. 
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